Managing Your ResCarta® Collections

Using the ResCarta Toolkit version 3.0.4

October 2011
The ResCarta® Toolkit is a product of the ResCarta Foundation, Inc. La Crosse, Wisconsin.

Using the ResCarta Toolkit, Version 3.0.4, October, 2011

This document provides a brief introduction to the tools included in the ResCarta Toolkit. More information is available from the ResCarta Foundation's website (http://www.rescarta.org); you can also contact the ResCarta Foundation via email: info@ResCarta.org

Copyright © 2011 ResCarta Foundation, Inc.

Other trademarks and registered trademarks referred to in this document:

Apple and Mac OS are trademarks or registered trademarks of Apple® Computer, Incorporated.
Java and Sun are trademarks or registered trademarks of Sun® Microsystems, Incorporated.
Linux is a registered trademark of Linus Torvalds.
Lucene is a trademark of The Apache Software Foundation.
Pentium is a registered trademark of Intel® Corporation.
Red Hat is a registered trademark of Red Hat®, Incorporated.
ResCarta is a trademark of the ResCarta Foundation, Inc.
Microsoft and Windows are registered trademarks of Microsoft® Corporation.

All other trademarks and copyrights referred to are the property of their respective owners.

This product includes software developed by the Apache Software Foundation (http://www.apache.org). Copyright © 2001 The Apache Software Foundation. All rights reserved.

TIFF Decompression provided by FreeImage.
# Table of Contents

Table of Contents.............................................................................................................. 1

New to 3.0.4 from 2.x.x ............................................................................................................ 1

Background................................................................................................................................................... 1

Scanning Parent Directory ............................................................................................................................ 1

Overview....................................................................................................................................................... 1

Overview....................................................................................................................................................... 2

Installing the ResCarta Toolkit ..................................................................................................................... 3

ResCarta Metadata Creation Tool ................................................................................................ ................. 6

ResCarta Data Conversion Tool ........................................................................................................ 13

Data Conversion tool “Document by file” mode: .................................................................................. 15

ResCarta Textual Metadata Editor............................................................................................... ............... 17

ResCarta Collections Manager................................................................................................... ................. 21

For Oai_DC................................................................................................................................................ 27

ResCarta Indexer.......................................................................................................................................... 28

Data Format Update Tool ......................................................................................................................... 32

Uninstalling the ResCarta Toolkit........................................................................................................... 33

Appendix:................................................................................................................................................ 36

---

**New to 3.0.4 from 2.x.x**

- Shared Metadata Institutional Ids/Aggregator/Rootid tracking .................................................. 7
- Create Section Breaks for chapters, issues, divisions .............................................................. 10
- Dublin Core output from the Collection Manager ........................................................................ 27
- Indexing Preferences ...................................................................................................................... 30
- Advanced ResCarta System Properties (JavaScripting, JPEG compression, etc.) .................. 36
- Error logging .................................................................................................................................... 33

**WARNING DATA LOSS MAY OCCUR** ................................................................................... 39
Background

ResCarta® standards for scanning and naming conventions:

Please review the following guidelines for digital documents to determine how to scan, photograph, and name your images; your data should meet these requirements for the tools of the ResCarta Toolkit to create a proper archive:

- Scan book pages as any of the following:
  - Bitonal, 600 DPI, G4 compressed TIFF files (suitable for pages containing mostly text, halftoned photographs, and etchings).
  - Grayscale, 300 DPI, 8-bit, uncompressed TIFF files (suitable for pages containing mostly black-and-white continuous tone images).
  - Color, 300 DPI, 24-bit, uncompressed TIFF files (suitable for pages containing spot color or color images).
- Save all images using a unique, sequential naming convention. For example, 00000001.tif, 00000002.tif, 00000003.tif, etc.
- Save all images that represent a particular document in the same directory, and store all directories that represent your documents under the same “parent” directory. For example, the .tif images in the preceding example might be stored in a book0001 (document) directory, which would then be stored in another directory (the “parent” directory in which all documents are stored).

The ResCarta Toolkit also works with TIFF, JPEG, PDF (image only), PDF (image and text) and PDF (Normal/Text) files.

Note: The requirements here are a summary of the complete standards, which are available at the ResCarta Foundation’s website: http://www.rescarta.org

Scanning Parent Directory

```
<table>
<thead>
<tr>
<th>Photo-directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000001.jpg</td>
</tr>
<tr>
<td>00000002.tif</td>
</tr>
<tr>
<td>00000003.jpg</td>
</tr>
<tr>
<td>00000004.jpg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>book0001-directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000001.pdf</td>
</tr>
<tr>
<td>00000002.pdf</td>
</tr>
<tr>
<td>...</td>
</tr>
<tr>
<td>00000224.pdf</td>
</tr>
<tr>
<td>00000225.pdf</td>
</tr>
</tbody>
</table>
```
Overview

How the ResCarta Toolkit works with ResCartaWeb:

ResCartaWeb is a customizable web site with the ability to display and search a database of ResCarta objects. The ResCarta Toolkit allows you to create, manage, manipulate, and check the ResCarta-formatted data accessed by ResCartaWeb, as well as add books or objects from your ResCarta database.

Before you install the tools, make sure you have the correct Java Runtime Environment (see page 3). Also, uninstall any older versions of ResCarta tools you may have on your system.

There are seven tools in the complete ResCarta Toolkit. Using these tools will help you create a standard archive of data that you can view and search using ResCartaWeb or import into other web discover-display systems. You may need to use all seven or just a few of the tools, depending on what you want to accomplish.

For new images that you’ve digitized and are adding to your ResCarta database, you will need to use tools that will convert images into ResCarta format. Specifically, you will need to use the ResCarta Metadata Creation Tool (see page 6) and the ResCarta Data Conversion Tool (see page 13).

For images that have not been OCR-ed, or for images to which you want to add searchable text (photographs, maps, etc.), you will need to use the ResCarta Textual Metadata Editor (see page 17) so that these images will be searchable with ResCartaWeb.

Whenever you make any change to your ResCarta database, (e.g., adding books or collections, images, changing the metadata, etc.), you must manage that change by using the ResCarta Collections Manager (see page 21) as well as index any changes by using the ResCarta Indexer. The ResCarta Collections Manager allows you to add and delete titles and edit metadata. The ResCarta Indexer (see page 28) insures that the new data you’ve added is added to the index so that when you use ResCartaWeb’s search function, the new data will be searchable, along with the older data.

To verify the integrity of your data, you will want to use the ResCarta Checksum Verification Tool (see page 31). This tool, used after data has been converted to the ResCarta format, compares computed values of data to ensure accuracy. If you have created data with a previous version of ResCarta tools you may have to run the Data Format Update Tool to adjust the metadata.xml files for each digital object.

The tools included in the ResCarta Toolkit do not have to be installed on the same computer on which your ResCarta database is stored, or on your ResCartaWeb server computer (regardless of whether the two are located on different machines). However, the computer on which you install the tools should have network access to the ResCarta database, to transfer digital objects to the ResCarta database after they’ve been converted to ResCarta format and edited as needed.

Note: The ResCarta tools and ResCartaWeb can be downloaded from the ResCarta Foundation’s website: http://www.rescarta.org
Installing the ResCarta Toolkit

You can install any or all of the tools in the ResCarta Toolkit at any time. The tools are not required to be installed on the computer on which your ResCarta database is stored, or on your ResCartaWeb server computer (regardless of whether the two are located on different machines), but the computer on which the tools are installed should have network access to the ResCarta database computer. Before installing the ResCarta Toolkit, be sure that the computer on which you intend to install the toolkit meets the requirements for installation.

Note: While the ResCarta Toolkit may be installed on other operating systems, such as Apple® Mac OS®, Red Hat® Linux® or Ubuntu; using the InstallRcTools_#._#.jar file, information in this document is specific to Windows systems. For information on installing the ResCarta Toolkit on other operating systems, please contact the ResCarta Foundation at info@ResCarta.org

Requirements for installing the ResCarta Toolkit:

- 1 GB RAM
  Note: 1 GB is the required amount of RAM for use with the ResCarta Toolkit; 2 GB or more RAM is recommended, especially for use with larger volumes of data (500,000 images).

- Sun® Microsystems Java™ Runtime Environment (JRE) 1.6.0 or greater
  Note: The latest version of the JRE is always recommended, and can be downloaded from the Java website at: [http://www.java.com](http://www.java.com)

  Tip: To determine whether a machine already has a JRE installed, from the Windows Start menu, select Settings, and then select Control Panel. Control Panel opens. If Java is installed, it will appear in the list. Double-click Java to open the Java Control Panel, and on the General tab, click About. The About Java window appears. If the version of the installed JRE is 1.5.0 or greater, you are ready to install the ResCarta Toolkit (see page 4); if not, you must first install the JRE (see next procedure).

- If you wish to convert Normal PDF files, you will need to download Ghostscript 8.70 or later from [http://pages.cs.wisc.edu/~ghost/](http://pages.cs.wisc.edu/~ghost/) or [http://sourceforge.net/projects/ghostscript/](http://sourceforge.net/projects/ghostscript/).

To install the Java Runtime Environment (JRE):

Note: It is strongly recommended that you exit all Windows programs before installing the JRE.

6. Open Windows Explorer, navigate to the JRE’s executable installation file, and then double-click it.

7. The InstallShield Wizard appears, preparing to guide you through the Java platform installation process.

    Note: You can cancel the JRE installation at any time before it’s complete by clicking Cancel in any of the installation windows. After you click Cancel, a Setup window opens to confirm that you want to cancel the Java installation process (click Yes to cancel the JRE installation, or click No to return to the installation).

8. The License Agreement window appears. Read the information in this window carefully, and then select the type of Java setup you want to use. You must accept the agreement to continue the Java installation.
Note: The ResCarta Foundation recommends Typical setup for use with the ResCarta Toolkit. Click Accept to continue.

9. The Installing Java 2 Runtime Environment window appears for the specific version of the JRE you’re installing, and Java installation begins. When installation is complete, the Installation Complete window appears.

Click Finish to complete the installation process.

Note: You may be notified that you need to restart your computer; in that case, you will be given the opportunity to reboot immediately or at a later time. You may select either option, but be sure to reboot before beginning to install the ResCarta Toolkit.

To install the ResCarta Toolkit:

After you’ve confirmed that the JRE version 1.6.0 or greater is installed or have completed the installation process, you are ready to install the ResCarta Toolkit. You may install all the tools included in the ResCarta Toolkit or a selection. Complete the following installation sequence for the tools that you want to install.

Important! If you’re installing an updated version of one or more of the tools in the ResCarta Toolkit, you should uninstall the older version of the tool(s) before installing the newer version. For more information on uninstalling these tools, refer to Uninstalling the ResCarta Toolkit (see page 33).

Note: It is strongly recommended that you exit all Windows programs before installing the ResCarta Toolkit.

1. Open Windows Explorer, navigate to the Toolkit’s executable installation file, and then double-click the file.

2. Note: The full file name of the executable file contains numbers and underscores immediately preceding the .exe extension. This portion of the file name represents the version number of the tool, and is not included in this reference document.

3. The IzPack Wizard appears, preparing to guide you through the installation process for the tool you selected.

Note: You can cancel the installation of any of the tools at any time before it’s complete by clicking Cancel in any of the installation windows. After you click Cancel, a Setup window opens to confirm that you want to cancel the installation process (click Yes to cancel the installation of the tool, or click No to return to the installation).

4. The Setup Wizard’s Welcome window opens. Read the information in this dialog and click Next to continue. You will be asked to accept the terms of the applicable licenses. Click “I accept” and next to continue.

5. The Setup Wizard’s Select Destination Directory window opens. Select the folder in which you want to install the tools.

Note: The default destination directory for the tools included in the ResCarta Toolkit is as follows:

C:\Program Files\RcTools-#.## where #.## is the current version number.

To select a different destination directory, enter the path to the folder in which you want to install the tools or browse to the desired installation location. On Vista, you may install into your personal directory since the installer is not allowed to install into the \Program Files area.unless you are installing AS the ADMINISTRATOR. Click Next to continue.
6. Select installation packages from the next dialog box. Select the tools you wish to install on your computer system by clicking on the checkboxes. Press the Next button to continue.

7. The Setup Wizard’s Installing window opens and installation begins. The installation progress bars will show the individual and overall progress of the installation. After completion of the installation, the installer will ask if you want start menus and if the software should be set up for your user or all users of this system.

Note: The default Start menu folder for all of the tools included in the ResCarta Toolkit is ResCarta Tools-#.##.

To select a different Start Menu folder, enter the name of the folder in which you want to display the tool’s shortcuts, or browse to the desired display location.

If you choose to install Tomcat or Ghostscript and then cancel the installation dialog for those packages the installer will leave those installers in your installation directory.

Click Next to continue.

8. When installation is complete, the Setup Wizard’s Completing window opens.

Click Done to close the Setup Wizard window and exit setup.

After you’ve completed the installation for each of the seven tools, the ResCarta Toolkit is completely installed and ready for use.
ResCarta Metadata Creation Tool

Use the ResCarta Metadata Creation Tool to create document metadata (information about your images that’s stored with them in a digital format). Any new, digitized document that you create for inclusion in your ResCarta database needs document metadata in order to be recognized by ResCartaWeb.

To create metadata in “Document per Directory” mode:

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you specified during installation (see “To install the ResCarta Toolkit,” page 4, and then select ResCarta Metadata Creation Tool.

   Note: The version number of the ResCarta Metadata Creation Tool is also included as the last part of its Windows Start menu option name, but is not included in this document.

   The ResCarta Metadata Creation Tool appears.

2. From the File menu, select Open image data directory.

3. From the Mode dialog, select Document per directory, press the radio button and click OK.

   The Select directory dialog appears.

4. Enter or browse to the directory in which the images for which you want to create metadata are stored and click Select directory.

   Note: Because the ResCarta Standard requires that all images representing a particular document are stored in the same directory and all directories representing documents are stored under the same “parent” directory, enter or browse to that parent directory to work with any or all of the documents included within it.

5. The Image data directory opened window appears to inform you how many subdirectories (representing documents) were found within the parent directory you selected. Click OK to continue.
6. The **ResCarta Metadata Creation Tool** now displays a list of documents within the parent directory you selected (in the left pane) and displays metadata associated with the current document (in the right pane).

*Note:* Documents are listed by their directory location and file name until **Title** metadata is assigned. **Documents** for which no metadata has been created are indicated with an exclamation point icon: 🔄. **Documents** for which metadata exists are indicated with a book icon: 📖.

*Tip:* You can view the entire directory location and file name (for documents for which no metadata has been created) or title (for documents for which metadata already exists) of any item in the **Documents** list by briefly pausing your mouse pointer over the item; the complete directory location and file name or title appears next to your mouse pointer.

7. To select a document, click its name in the **Documents** list. Any available metadata for that document is listed on the right.

8. To view images for the current document, click **View images**. An image viewer appears, displaying the first image in the current document. This viewer includes many of the same viewing options that are available in ResCartaWeb’s viewer:

Refer to ResCartaWeb’s Help for more information on using these viewing options.

A few of the viewer options do not exist within ResCartaWeb:

These options are, respectively, **Best fit** (displays the image at the height and width that are proportionally sized to fit the viewer), **Fit to width** (displays the image at the largest width that fits the viewer), **Fit to height** (displays the image at the largest height that fits the viewer), and **Go to page** (opens a dialog for you to select a specific image in the document to view).

When you’re finished viewing the images within the document, click the viewer’s **close window** button.

9. To create new metadata for the current document, click **Create metadata**.

*Note:* If metadata already exists for the current document, the **Create metadata** button is not available; use the **Modify metadata** button to modify the existing metadata.

*Shared or local Identifiers:* From the **File** menu, select **Preferences** and click the Shared file radiobutton. This will set the location of the file to store your identifiers. It can be a local user or a network shared location. If you have started using ResCarta tools alone and want to share the information with a team, select **Shared File**, enter or browse for a network location where you and your team have write permission and then press **Synchronize with User Configuration** this will allow you to share your existing Institution Identifiers and coordinate your team.

- The Select source institution dialog appears. Select the source institution you want to use and click **Ok**.
To add a new source institution, click **Add**. The Add institution dialog appears. Enter the **Id** for your source institution (8 character alpha-numeric), enter the full **Name** of your source institution (optional), and click **Finish**.

*Important!* The source institution identifier **must** be eight characters (letters and/or numbers) in length. You can use multiple source institution identifiers with your ResCarta collections, but a source institution identifier is **required** for each document. To avoid collisions when sharing data with other institutions, this identifier must be unique to your institution. If your institution has a code in the MARC Code List for Organizations, we recommend that you use that code, padded to the right with zeroes for a total of eight characters, as the source institution identifier. For example, the MARC code for the New York Public library is **NN**; therefore, the recommended source institution identifier for the New York Public Library is **NN000000**, Rescarta’s MARC code is WiOnRFI, which is normalized to wionrfi0.

To modify an existing source institution, select the institution you want to change and click **Modify**. The Modify institution dialog appears. Change the **Id** and/or **Name** of the source institution as needed and click **Finish**.

To remove a source institution, select the institution you want to remove and click **Remove**. The Confirm institution removal dialog appears. Click **OK** to remove the source institution; click **Cancel** to cancel the institution removal process.

- The Select aggregator and root id dialog appears. Enter the **Aggregator** and **Root id** you want to use and click **Ok**.
Important! The aggregator and root identifier must each be eight characters (letters and/or numbers) in length. An aggregator and root identifier are required for each document in your collection.

Note: Collectively, the source institution identifier (Id), aggregator (Aggregator), and root identifier (Root id) that you just specified comprise the object identifier, which must—in combination—be unique for each object, so that it can specify the location of that object. This directory structure (institution identifier/aggregator/root identifier) is referenced throughout the ResCarta Toolkit.

- The Select metadata type dialog appears. Select the type of the current document (Monograph, Serial monograph, Serial, Photo or Newspaper) and click Ok.

- The Create monograph metadata, Create serial monograph metadata, or Create serial metadata dialog appears, depending on the type of metadata you selected for the current document; the Create monograph metadata dialog is shown here:

Note: A Title is required to add metadata to a document; if you are adding serial monograph or serial documents, a Volume is also required. The ResCarta Foundation recommends completing as much metadata as possible for all documents in your collection.
Information that you can enter includes: **Title, Volume** (for serial monograph or serial documents only), **Abstract, Alternative titles, Authors, Owner, Type of resource, Genre, Publisher name, Place of publication, Publication date, Capture date, Language, Size, Note, Subjects, Issues, and Pages.**

*Note:* Creating, changing, or removing metadata for **Alternative titles, Authors, and Subjects** requires the use of the **Add, Modify, and Remove** buttons, respectively. These buttons appear directly below the section for which they’re used. An image viewer is included in the **Pages** section for convenient page reference to **Modify page metadata click a page name with the second mouse button** this accesses the Modify page metadata dialog for renaming pages. You can select a range of pages and rename them to an Arabic or Roman range.

*Tip:* To create section breaks like chapters, issues, and divisions or to denote an index; click a page name with the second mouse button and select “Add Section Break” from the dialog.
You can then add a tag name to the page for a section break. This text is stored in the logical structure of the object. This is the same method used for creation of issue breaks when creating metadata for Serial objects.

Tip: The Publication date and Capture date must be specified in one of the following, three ISO formats, where YYYY is the year (four-digit format), MM is the numeric value of the month (in two-digit format), and DD is the day (also in two-digit format): YYYY-MM-DD, YYYY-MM, or YYYY.

- Click to save your changes; or click to close the Create monograph metadata, Create serial monograph metadata, or Create serial metadata dialog without saving your changes.

10. To modify existing metadata for the current document, click Modify metadata.
Note: If no metadata exists for the current document, the Modify metadata button is not available; use the Create metadata button to create new metadata.

11. To remove all metadata from the current document, click Remove metadata. The Confirm metadata removal window appears. Click OK to remove all metadata from the current document; click Cancel to cancel the metadata removal process.

Note: If no metadata exists for the current document, the Remove metadata button is not available.

12. When you’re finished creating metadata, click the ResCarta Metadata Creation Tool’s close window button. The confirm exit window appears. Click OK to exit; click Cancel to return to the ResCarta Metadata Creation Tool.

Note: Document metadata is saved in the metadata.xml file, in the directory in which the image files for that document are stored. This metadata is saved in the METS (Metadata Encoding & Transmission Standard) format. For more information about METS, refer to the METS website at the Library of Congress: http://www.loc.gov/mets/

To create metadata in “Document per file” mode:

From the Windows Start menu, select Programs, then select the Start Menu folder that you specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta Metadata Creation Tool.

The ResCarta Metadata Creation Tool appears.

1. From the File menu, select Open image data directory.
2. From the Mode dialog, select Document per directory.
3. The Select directory dialog appears.
4. Enter or browse to the directory in which the images for which you want to create metadata are stored and click Select directory.

This will allow you to add a metadata.xml file for each file in the directory. You can apply individual metadata elements to each file. This is primarily used for multipage PDF file conversion. Proceed as with step 5 above to produce metadata files.
ResCarta Data Conversion Tool

Use the ResCarta Data Conversion Tool to convert your TIFF, JPEG, PDF (image only), and PDF (image and text) into ResCarta archive data format. Any new, digitized document that you create for inclusion in your ResCarta database needs to be converted into this format in order to be recognized.

To convert your images into ResCarta format:

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta Data Conversion Tool.

2. Click the button to the right of the Source data directory text field to specify the directory in which your source documents are located. The Select directory dialog appears.

3. Enter or browse to the Source data directory (the directory in which the documents you want to convert are stored) and click Select directory.

   Note: Because the ResCarta Standard requires that all images representing a particular document are stored in the same directory and all directories representing documents are stored under the same “parent” directory, enter or browse to that parent directory to work with any or all of the documents included within it.

4. Click the button to the right of the Destination directory text field to specify the directory into which your converted documents will be placed. The Select directory dialog appears.

5. Enter or browse to the Destination directory (the directory into which the converted documents will be placed) and click Select directory.
Important! The destination directory can be located wherever you specify, if it does not exist at the time you begin the conversion process it will be created, it must be named RCDATA01 (upper case).

Safety Note: Do not use your ResCarta database (the intended final location of your data) as your destination directory; use an intermediate location during the conversion process, and then transfer converted data from this intermediate location to your ResCarta database.

6. Select the Source data type as Document per directory from the pull down and select the Source metadata type as ResCarta Mets.

   Note: The Source metadata type for Documents per directory is currently restricted to ResCarta METS. Future versions of the ResCarta Data Conversion Tool will include support for other source metadata types.

7. Enter the name of the Source metadata filename as metadata.xml, and click Begin conversion.

   Note: If you created metadata using the ResCarta Metadata Creation Tool (see page 6), the source metadata filename is metadata.xml; if the source metadata filename you specify does not exist in a document directory, the conversion process will fail.

The progress of the conversion process is detailed in the Status (lower) section of the ResCarta Data Conversion Tool, and you will be notified when the process is complete.

Note: Depending on the number and size of the documents in your source data directory, the conversion process may take some time; for larger data sources, you may want to run your conversion process overnight. Converted images are saved in archive TIFF format with metadata preserved in the file in MODS (Metadata Object Description Schema) format. For more information about MODS, refer to the MODS website at the Library of Congress: http://www.loc.gov/mods
8. When the conversion is completed, click the ResCarta Data Conversion Tool’s close window button. 

Note: The ResCarta Data Conversion Tool creates the following directory structure under your RCDATA01 (destination directory, as specified in step 5): institution identifier/aggregator/root identifier. These three terms, which comprise the object identifier for a particular document, are defined when you use the ResCarta Metadata Creation Tool (see step 9, page 7). For example, if your Id is brookhav, your Aggregator is 00000001, and your Root id for a particular document is 00000026, the following directory structure appears for that document under your RCDATA01 destination directory: brookhav/00000001/00000026.

Data Conversion tool “Document by file” mode:

The Document by file mode of the Data conversion tool allows for the conversion of multipage PDF files into ResCarta objects. It can convert multipage NORMAL, Image and text and Image only PDFs.

NORMAL PDF files contain fonted text and do not contain a complete raster image of the document page. The ResCarta tool will need the assistance of GHOSTSCRIPT to convert the fonted text data into TIFF raster format. This process used to be known as a RIP (“Raster Image Processor”), which prepared Postscript files for printing on raster laser printers. You can download GHOSTSCRIPT from http://pages.cs.wisc.edu/~ghost/doc/GPL/ or http://sourceforge.net/projects/ghostscript/

Proceed with the first five steps from the previous section. Then

6. Select Source data type as “Document per file” from the pulldown.

7. Now you have the option of using individual metadata.xml files created earlier using the Metadata Creation tool or apply a set of standard metadata to all the files in the directory. Select the Source metadata type of “Apply default metadata to all documents”.

8. Now proceed to set the default metadata to be used. Enter the Institution Id for these documents. Enter the starting Aggregator and Root Id (see Metadata Creation tool on page 8 for more on this.)

9. Set the Default metadata by pressing the Set button. You will be asked to Select the metadata type (Monograph, Serial, Serial Monograph) and then press the Ok button. The Set default metadata dialog will open (see page 9) Enter the items that will be applied to ALL the documents in this directory. Then press the Finish button at the bottom of the dialog.

10. If you would like the tool to extract existing metadata from the PDF files use the PDF Options check boxes. 

    • Read PDF title will extract the title from the existing PDF and if not checked or not found will replace the title with the file name from the document.

    • Read PDF author will extract the author information if it exists else it will use the author information entered in the Set default metadata dialog.

    • Serial Options will be grayed out for Monographs. If you are converting a number of Serials you can use the spinners to set the Starting volume number, Starting issue number and the length of the padding on the Volume and Issue strings. You may also choose to increment the volume or the issue per each file encountered.

11. Error handling can be controlled from the three Error handling check boxes.
- **Continue on error** does just that. The program will continue when it encounters an error.
- **Write error log** check box will write a log of any files it has problems with or errors encountered during conversion.
- **Separate problem documents** check box will create a new directory below the existing working directory and move any problem files into that directory.

Press the Begin conversion button when you have completed your selections. The program will show the status of the conversion in the lower pane. You may copy this status information using the operating system’s copy/paste key combinations.

Note: see the appendix for details about options to the data conversion process.
ResCarta Textual Metadata Editor

Use the ResCarta Textual Metadata Editor to add, edit, or delete textual metadata (searchable words that are stored with document images) to ResCarta-formatted documents. Any documents that were scanned without OCR (Optical Character Recognition) need textual metadata, or they cannot be located in searches conducted with ResCartaWeb. You may also want to add searchable text to photograph pages in documents, or to edit existing textual metadata in OCR-scanned pages.

Note: You must use the ResCarta Data Conversion Tool (see page 13) before using the ResCarta Textual Metadata Editor.

To add or edit textual metadata:

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta Textual Metadata Editor.

Note: The version number of the ResCarta Textual Metadata Editor is also included as the last part of its Windows Start menu option name, but is not included in this document.

The ResCarta Textual Metadata Editor appears.

2. From the File menu, select Open ResCarta object directory.

The Select ResCarta object directory dialog appears.

3. Enter or browse to the ResCarta object directory (document directory; the lowest level of directory structure in documents that have been converted to ResCarta format) in which you want to add or edit textual metadata and click Select ResCarta object directory.
Note: If you used the ResCarta Data Conversion Tool to convert your data in the ResCarta format, the following directory structure exists under your RCDATA01 (destination directory, as specified in step 5, page 13 in the ResCarta Data Conversion Tool section): institution identifier/aggregator/root identifier. These three terms, which comprise the object identifier for a particular document, are defined when you use the ResCarta Metadata Creation Tool (see step 9, page 7); they also define your ResCarta object directories.

4. The ResCarta Textual Metadata Editor now displays a list of Pages in the document within the ResCarta object directory you selected (in the upper left pane) and the existing textual metadata (Words) for the current page (in the lower left pane). The rest of the tool displays the current page (in the right pane).

5. To select a page, click its number in the Pages list. Any textual metadata (Words) that exists for that page is listed and selected (In the words pane). The page display (in the right pane) highlights any of the Words for which coordinate location values exist, as shown in the following example:

Note: The page display area includes some of the same viewing options that are available in the ResCarta Metadata Creation Tool's viewer (for more information, see page 7).

6. To add textual metadata, use the insert button that indicates the location you want to place your new word in the list of Words:

Tip: If the order of words in the textual metadata (and in the Words display list) is not important to you, it is immaterial which insert button you use; the order of the words is not relevant to their coordinate positions, if any are specified at all.

- To add a word before another word, select the existing word (the word before which you want to insert a new word) and click Insert before.

- To add a word after another word, select the existing word (the word after which you want to insert a new word) and click Insert after.
To add a word on a page that doesn’t yet include any words, click **Insert**.

*Note:* If the current page doesn’t yet include any words, the **Insert** button replaces the **Insert before** button; if more than one word is selected, **Insert before** and **Insert after** are not available.

The Insert word dialog appears. Enter the information for the word you’re inserting:

- Enter the **Word** you’re inserting.
- Enter the **Font name** that was used to render the word on the page.
  
  *Tip:* If you don’t know this information exactly, enter the font name that best approximates the displayed font (e.g. Helvetica, Times-Roman).
- Enter the **Point size** of the word on the page.
  
  *Tip:* The Point size is currently reserved for future use; if you don’t know this information, enter the point size that best approximates the displayed size.

*Note:* X1, Y1, X2, and Y2 values are not entered cannot be highlighted during searches of your collections.

- Enter the X1 coordinate of the word (lower left X coordinate).
- Enter the Y1 coordinate of the word (lower left Y coordinate).
- Enter the X2 coordinate of the word (upper right X coordinate).
- Enter the Y2 coordinate of the word (upper right Y coordinate).

7. To edit textual metadata for an existing word, select the word you want to edit and click **Modify**.

*Note:* If the current page doesn’t yet include any words or more than one word is selected, **Modify** is not available.

The Modify word dialog appears. Enter the information for the word you’re modifying (refer to the preceding step for more details on the information that’s required in this dialog).

8. To remove a word from the current page, select the **Word** you want to remove and click **Remove**.

The Confirm word removal window appears. Click **Yes** to remove the word from the current page; click **No** to cancel the word removal process.

9. When you’re finished adding and editing textual metadata, click the **ResCarta Textual Metadata Editor**’s **close window** button. The confirm exit window appears. Click **OK** to exit; click **Cancel** to return to the **ResCarta Textual Metadata Editor**.

The Utility menu.
The Utility menu contains an item called “Correct ABBYY OCR”. This menu item was only used for data converted by the ABBYY OCR program version 8.00 and converted with earlier versions of the ResCarta Data conversion tool. In this version the data exported by the OCR package in PDF output stripped the last character of each word from the end of the word. This caused the ResCarta Data conversion tool to create a separate word for the last character of each word in a document. So the phrase “exact artist, made even important errors” in the page below would be rendered as “exac”, “t”, “artist”, “,”, “eve”, “n”, “important”, “t”, “error”, “s” in the ResCarta word list. Searching for the phrase “exact artist” would still work because ResCarta Web would concatenate the “Four” words “exac”, “t”, “artist”, “,” . See the page below for an example.

Note: This menu item has now been disabled since all problems with versions of ABBYY have been corrected within the Data conversion tool.
ResCarta Collections Manager

Use the ResCarta Collections Manager to manage your ResCarta collections. Any change you want to make to your collections, such as adding or removing documents, is managed through this tool.

Important! You should copy your ResCarta data from its intermediate location to your ResCarta database (its intended final location) before using the ResCarta Collections Manager. Use a file manager (such as Windows Explorer) to locate your intermediate RCDATA01 folder, and copy the directory or directories immediately beneath this folder (your institution identifier directory, as specified in the ResCarta Metadata Creation Tool section, step 9, page 7; if you’ve used more than one institution identifier, you will have more than one directory to copy) to the same directory level of the computer on which your ResCartaWeb database is stored (immediately beneath the RCDATA01 folder).

Note: After making any changes to your ResCarta collections, objects (ResCarta-formatted documents), or metadata, the ResCarta Indexer must be run to update the index (see page 28).

To manage your ResCarta collections:

Note: The following information is also accessible from within the ResCarta Collections Manager: from the Help menu, select Help contents.

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta Collections Manager.

   Note: The version number of the ResCarta Collections Manager is also included as the last part of its Windows Start menu option name, but is not included in this document.

   The ResCarta Collections Manager appears.

   ![ResCarta Collections Manager](image)

   - Collections
     - Open a ResCarta data volume

   - Add
   - Modify
   - Remove

2. To open a ResCarta Data Directory:

   Note: The ResCarta data directory will be named RCDATA01(uppercase).
• From the **File** menu, select **Open ResCarta volume**.
  The Select directory dialog appears.
• Enter the path to the directory that contains the data you want to work with in the **File Name** box or browse to the directory and then click **Select directory**.
  
  *Note:* If you have a large number of ResCarta documents in the directory you’re opening, you may notice a delay as the documents are accessed.
• After the ResCarta Data Directory you selected opens, a dialog appears to inform you that it opened successfully and details the number of ResCarta objects that were found there. Click **OK** to close this dialog.

3. The **ResCarta Collections Manager** displays **Collections** in the volume you selected (in the left pane) and information about the current collection (in the right pane).

  *Note:* **Collections** are indicated with a stacked book icon 📚 (in the left pane). **Objects** (documents) in collections are indicated with a book icon 📖 (in the right pane), with the total number of documents in the current collection displayed at the bottom of the **Objects** list.

  **Tip:** To copy an **object identifier** (see step 9, page 7) or the complete path to an object, move your mouse pointer over the object for which you want to copy information and right-click; from the menu that appears, select **Copy object id to clipboard** or **Copy path to clipboard**, respectively.)

4. To create a collection:

  • Click the **Add** button in the **Collections** pane on the far left of the **ResCarta Collections Manager**.

  The Add collection dialog appears.

  ![Add collection dialog](image)

  • Enter the **Collection title** you want to use, enter an abstract of the collection and then click the **Finish** button.

  *Note:* The collection title can contain letters, numbers, and/or spaces.

  Your new collection title appears in the **Collections** list and the total number of objects in the current collection is displayed at the bottom of the list.
5. To add objects to a collection:

Select the collection you want to add objects to in the Collections pane (on the left side of the ResCarta Collections Manager).

Objects in the selected collection are displayed on the Collection content tab (in the right pane); the total number of objects in the current collection is displayed at the bottom of the Objects list.

Tip: Use the View drop-down at the bottom of the Objects section to display objects by Title or Id (object identifier; see step 9, page 7).

- On the Collection content tab, click the Add button under the list of Objects that are currently included in the collection.

The Add Objects dialog appears, listing all available data in the current ResCarta Data Directory; the total number of objects with respect to the current Filter (see the following tip) is displayed at the bottom of the Objects list.

Note: Metadata for the currently selected object is displayed (in the right pane of the Add Objects dialog) for reference; this information can be edited after the object is added to a collection (see the following step). The page display area (at the bottom of the right pane of the Add Objects dialog) includes some of the same viewing options that are available in the ResCarta Metadata Creation Tool’s viewer (for more information, see page 7).

Tip: Use the View drop-down at the bottom of the Objects section to display those documents by Title or Id (object identifier; see step 9, page 7). Use the Filter drop-down at the bottom of the Objects section to display All (all objects in the your ResCarta volume), Not in current collection (only objects in your ResCarta volume that are not included in the current collection, as shown in the preceding example), or Not in any collection (only objects in your ResCarta volume that are not included in any collection).
Select the object or objects you want to place in the collection.

- To select a single object, click it.
- To select multiple objects that appear adjacent to one another in the list, press and hold the Shift key as you click the first and last of the adjacent objects you want to place in the collection; the rest will be selected automatically.
- To select multiple objects that do not appear adjacent to one another in the list, press and hold the Ctrl key as you select the objects you want to place in the collection; you must click each individual object you want to select.

Click Finish to add the selected object or objects to the collection.

Note: You may add the same object to more than one collection; the metadata will be maintained independently.

6. To remove an object from a collection:

- Select the collection you want to remove an object from in the Collections pane (in the left pane). Objects in the selected collection are displayed (in the right pane, in the Collection content tab).
- On the Collection content tab, select the object you want to remove from the list of Objects that are currently included in the collection and click the Remove button under the list. The Confirm object removal dialog appears to confirm the object you want to remove, and the collection you want to remove it from.
- Click Yes to remove the object from the collection. Click No to close this dialog without removing the object from the collection.

Note: Removing an object from a collection does not remove it from its original location in the ResCarta Data Directory.
7. To modify object metadata:

*Note:* Changes made to metadata in one collection do not occur in that same object in other collections. **Size width, Size height, Issues,** and **Pages** cannot be modified using the ResCarta Collections Manager.

- Click the object for which you want to edit metadata.

![ResCarta Collections Manager interface](image)

*Note:* Use the scroll bar on the right to navigate to the fields you want to modify.

- To modify **Title, Volume** (for serial monograph or serial documents only), **Owner, Genre, Genre authority, Publisher name, Place of publication, Publication date, Capture date, Language,** and **Note** metadata, select the field you want to change and make the changes directly to the field in the Modify Objects dialog. The title of the field will turn green to note editing.

- To modify **Owner Type, Type of resource, Language authority,** and **Language type,** choose from the options in the drop-down list in the Modify Objects dialog.
To modify Alternative titles, Authors, and Subjects metadata, use the Add, Modify, and Remove buttons located under the field you’re modifying.

- To add information:
  
  Click the Add button under the field to which you want to add information. The Add dialog appears for the metadata you selected.

  ![Add Subject dialog]

  Enter the information you want to add to the field and click Finish. To close this dialog without saving your changes, click Cancel.

  Note: When you’re adding Subjects metadata, you must first select Subject type (Topic or Geographic). For Topic type metadata, enter Authority and Topic information. For Geographic type metadata, enter Country, State, and County information.

- To edit existing information:
  
  If multiple lines of information exist for the metadata you want to change, select the specific line you want to modify and then click the Modify button under the field. The Modify dialog appears for the metadata you selected.

  ![Modify Subject dialog]
Make the changes to the information that you want to include in the field and click **Finish**. To close this dialog without saving your changes, click **Cancel**.

**Note:** When you’re changing **Subjects** metadata, you may need to change **Subject type** (**Topic** or **Geographic**). For **Topic** type metadata, you can change **Authority** and **Topic** information. For **Geographic** type metadata, you can change **Country**, **State**, and **County** information.

- To remove information:
  
  If multiple lines of information exist for the metadata for which you want to remove information, select the specific line you want to remove and then click the **Remove** button under the field.

  The Confirm removal dialog appears for the metadata you selected, to confirm the information you want to remove. Click **Yes** to remove the information. Click **No** to close this dialog without removing the information.

- When you’ve finished modifying metadata, click **Finish** to save your changes. To close this dialog without saving your changes, click **Cancel**.

8. To save your changes to your ResCarta collections, from the **File** menu, select **Save collections data**. **Tip:** When you’re making a large number of changes, save your changes periodically rather than waiting to save your changes when you exit the **ResCarta Collections Manager**.

9. When you’re done managing your ResCarta collections, click the **ResCarta Collections Manager**’s **close window** button. The confirm exit window appears. Click **OK** to exit; click **Cancel** to return to the **ResCarta Collections Manager**.

**Note:** If there are changes to your collections that you haven’t yet saved, you will be prompted to save those changes before exiting the **ResCarta Collections Manager**.

10. **Saving Dublin Core Metadata.** You can now save your metadata in Dublin Core formatted xml files for use in other systems. From the **File** menu, select **Dublin Core Preferences**. The Dublin Core Preferences dialog appears.

   **To Create OAI_DC xml files for use in your OAI provider software.**

   1. Set the output directory to a central location.
   2. Enter the path of the output directory.
   3. Select OAI_DC as the output format.
   4. Enter the url of your ResCarta –Web site complete with the trailing slash.
   5. Press the **Ok** button
   6. Answer **Yes** to the write dialog.
ResCarta Indexer

Use the ResCarta Indexer to create a Lucene™ index of your ResCarta collections. Any changes you make to your collections (using the ResCarta Collections Manager; see page 21) require that a new index be built so that ResCartaWeb can accurately search the collection.

Important! Indexing a collection can be a time-consuming process, particularly in larger collections; the ResCarta Foundation recommends running ResCarta Indexer over a weekend.

To create Lucene indexes of your collections:

Note: The following information is also accessible from within the ResCarta Indexer; from the Help menu, select Help contents.

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta Indexer.

Note: The version number of the ResCarta Indexer is also included as the last part of its Windows Start menu option name, but is not included in this document.

The ResCarta Indexer appears.

If you’re creating an index for a ResCarta collection for the first time, set your Source data directory and Index destination directory and then click Begin indexing. The indexing process will begin and its status will be displayed in the Status window.

If you’ve made structural changes to your ResCarta collection metadata at the collection level (for example, adding or removing a collection) or object level (for example, adding or removing a book from a collection), you can also proceed to Begin indexing (see step 5) as soon as you’ve set your Source data directory (see next step) and Index destination directory (see step 3).

Other changes to the ResCarta collection metadata may require using of indexing Options (see step 4).
2. To select the **Source data directory**:
   - Click the button to the right of the **Source data directory** text field. 
     The Select directory dialog appears.
   - Enter the path to the directory that contains the data you want to work with in the **File Name** box 
     or browse to the directory and then click **Select directory**.
     *Note:* The ResCarta “source data directory” will be named **RCDATA01** (uppercase).

3. To select the **Index destination directory**:
   *Important!* ResCarta specifications require that indexes be stored in the **index.ar2** (lower case) 
   subdirectory of the **RCDATA01** (upper case) ResCarta data directory (**/RCDATA01/index.ar2**). If this directory does not yet exist, the index tool will create it.
   - Click the button to the right of the **Index destination directory** text field. 
     The Select directory dialog appears.
   - Select **index.ar2** subdirectory:
     - If the **index.ar2** subdirectory already exists in the **RCDATA01** directory, enter the path to the 
       **index.ar2** subdirectory or browse to the directory and then click **Select directory**.

4. To select indexing **Options**:
   There are two options that may be used when indexing: **Force rebuild** and **Force optimize on change**. To use either, or both, select the appropriate check box(es).
   - **Rebuild index**
     When you check **Rebuild index**, the **ResCarta Indexer** will build a new index *even if an index exists and there have been no changes in the data*. For example, if your index becomes corrupted, 
you need to use **Rebuild index** to create a new index.
     You will also want to use **Rebuild index** when you have used the **ResCarta Collections Manager** to change metadata for any of the objects in your collections. For example, if you 
change the title of a book or the subject, you must run the **ResCarta Indexer** with the **Rebuild index** option checked to create an index that reflects the changes.
   - **Optimize index**
     When you first build an index for a collection, the indexer *automatically* optimizes the index; you 
do not need to check **Optimize index** the first time you build an index for a collection.
     However, when you update an existing index, you must check **Optimize index** to optimize the 
index. Optimizing an index can take longer than building an index without optimizing, but it 
 improves index performance.
5. The progress of the indexing process is detailed in the Status (lower) section of the ResCarta Indexer.

6. When indexing is complete, click the ResCarta Indexer’s close window button.

7. Setting Preferences. From the FILE menu, select Preferences. The Indexing Preferences dialog appears.

![Indexing Preferences dialog](image)

The Output indexing performance data check box will increase the amount of information shown by the indexer. Normally you would see output like the following...

Indexing object: WISC-OCLC/oclc2010/20101101/00000059(0,108 of 0,113)...(Done, 1 pgs)
Indexing object: WISC-OCLC/oclc2010/20101101/00000060(0,109 of 0,113)...(Done, 1 pgs)
Indexing object: WISC-OCLC/oclc2010/20101101/00000061(0,110 of 0,113)...(Done, 19 pgs)
Indexing object: WISC-OCLC/wionrfi0/20100922/00001739(0,111 of 0,113)...(Done, 13 pgs)
Indexing object: WISC-OCLC/wionrfi0/20100922/00001740(0,112 of 0,113)...(Done, 3 pgs)

With the performance data checked you will see the following for each item indexed...

Indexing object: WISC-OCLC/wionrfi0/20100922/00001739(0,111 of 0,113)...(Done, 0,013 pgs, 000.0 sec, 00.000 sec per pg, heap 0.041.4MB, free 0.009.6MB)

The Strip underscores from indexed text check box option will do just that, any underscores in your data will be removed and replaced by a space. This has been added for converting data using the ResCarta Data Conversion tool where the original file names of the source files contained the title and underscores were used to separate the words.

The Index glob size spinner can be used to increase the size of each index part. The index created will be broken into parts when it exceeds the size set here. To date the index glob size has been set to 1 Gigabyte to maintain compatibility with all modern operating systems. With large collections (4 million images or more), and using 64bit operating systems in servers with lots of memory there is a performance enhancement when the glob size is increased.
ResCarta Checksum Verification Tool

Use the ResCarta Checksum Verification Tool to verify TIFF checksums (computed values of data that are compared to ensure data accuracy) of your ResCarta-formatted data, to ensure the integrity of the documents in your ResCarta database.

Note: You can use the ResCarta Checksum Verification Tool at any time after the data has been converted into ResCarta format. For more information on converting image data into the ResCarta format, refer to the ResCarta Data Conversion Tool documentation (see page 13).

To verify TIFF checksums of your ResCarta-formatted data:

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you specified during installation (see “To install the ResCarta Toolkit,” page 4), and then select ResCarta Checksum Verification Tool.

   Note: The version number of the ResCarta Checksum Verification Tool is also included as the last part of its Windows Start menu option name, but is not included in this document.

   The ResCarta Checksum Verification Tool appears.

2. Click the button to the right of the Source data directory text field to specify the directory in which your source objects are located. ... The Select directory dialog appears.

3. Enter or browse to the Source data directory (the directory in which the data for which you want to check accuracy is stored) and click Select directory. Select directory

   Tip: You may wish to check both the RCDATA01 directory on the computer on which your ResCarta database is stored and the RCDATA01 directory created by the ResCarta Data Conversion Tool (see page 13), to ensure the accuracy of your final and intermediate data, respectively; these verification processes must be run separately.
4. Click **Begin verification**.

The progress of the verification process is detailed in the **Status** (lower) section of the **ResCarta Indexer**, and you will be notified of any problems with your data.

**Note:** The **Begin verification** button is replaced by the **Cancel verification** button during the verification process; click **Cancel verification** at any time to stop the data-accuracy check.

5. When verification is complete, click the **ResCarta Checksum Verification Tool**’s **close window** button.

### Data Format Update Tool

A utility for bringing older ResCarta Collections up to date with the 2.33 toolkit.

With the release of this version of the ResCarta Toolkit, we have updated our METS implementation. In doing this we made changes to the way the ResCarta Collections Manager stores its METS metadata. If you have an existing ResCarta collection and want to add to this collection using the new ResCarta Toolkit version 3.0.4, you will need to run this Update tool ONCE against your existing collection. Please note that the utility allows you to revert your collection to a pre 3.0.4 state. If you run the tool more than once it will do no harm to your data.

Start the **Data Format Update Tool** and select the location of your ResCarta Data. Set the Target format to **3.0** and press the **Begin Update** button. The status of each file changed will be displayed in the status window frame.
Uninstalling the ResCarta Toolkit

To uninstall any or all of the tools in the ResCarta Toolkit, complete the following uninstallation sequence for the tool or tools you want to remove from your computer.

To uninstall the ResCarta Toolkit:

1. From the Windows Start menu, select Programs, then select ResCarta Tools.
2. From the list select Uninstall ResCarta Tools. The tool’s Uninstall window opens and the process of removing the tool from your computer begins.

3. If you intend to use ResCarta Tools in the future, please uncheck the “Force the deletion of “ the ResCarta tools directory. By doing this you can retain your institutional identifier and the next object id numbers. Click Uninstall to continue and remove the software or click Quit to stop and exit the uninstaller without removing software from your hard disk.

A note about Errors:

We work hard to create world-class software, but in the event that you encounter an unexpected error, a dialog box should appear and give you further instructions. If you get a blank dialog box (just an empty dialog) please note what you were doing and send the contents of the error log to the ResCarta Foundation at info@rescarta.org.

This will help us make better tools for you and everyone else. You can find the errors logs under your user directory like...

C:\Documents and Settings\{user name}\.RcTools\logs

Or

C:\Users\{user name}\.RcTools\logs
Glossary

The following terms and definition are used in relation to the ResCarta Toolkit:

**Aggregator** – The *aggregator* is a required identifier used to limit the number of ResCarta object folders in a single directory within the same source institution parent directory; it must be eight characters (letters and/or numbers) in length. You are required to supply an aggregator (or accept the preselected default) when you use the **ResCarta Metadata Creation Tool** to add metadata to a document.

**Checksum** – A *checksum* is an inspection of numeric values that accompany data, and is used to help determine the integrity of that data.

**Destination Directory** – The *destination directory* is the directory into which your converted documents will be placed when you use the **ResCarta Data Conversion Tool**.

**Metadata** – *Metadata* are structured data that describe a document in your collection. For example, title, volume, author, subject, etc.

**Monograph** – A *monograph* is a publication that’s complete as first issued, in one entity. Examples of monographs include books and maps.

**Object Identifier** – The *object identifier* is made up of the source institution identifier, aggregator, and root identifier. This directory structure (*institution identifier/aggregator/root identifier*) uniquely identifies each ResCarta object in your database, and is referenced in the **ResCarta Metadata Creation Tool**, the **ResCarta Data Creation Tool**, the **ResCarta Textual Metadata Editor**, and the **ResCarta Collections Manager**.

**Parent Directory** – A *parent directory* is the directory that is one level up from the current directory.

**Required Identifier** – A *required identifier* is information that must be entered for one or more tools in the ResCarta Toolkit to function.

**ResCarta Database** – The *ResCarta database* is the organized collection of all of your digital objects.

**ResCarta Object** – A *ResCarta object* is any document, book, photo, recording, etc that has been created or converted to a digital representation according to the ResCarta standards. This term is referenced by every tool in the ResCarta Toolkit.

**ResCarta Volume** – A *ResCarta volume* is a collection of ResCarta objects, stored according to the ResCarta standards. This term is referenced in the **ResCarta Collections Manager**.

**Root Identifier** – The *root identifier* is a required identifier used to distinguish the directory in which a digital object resides; it must be eight characters (letters and/or numbers) in length. You are required to supply a root identifier (or accept the preselected default) when you use the **ResCarta Metadata Creation Tool** to add metadata to a document.

**Sequential Naming Convention** – A *sequential naming convention* is one in which names are numeric, and increase sequentially. For example, 00000001, 00000002, 00000003, 00000004, etc.

**Serial** – A *serial* is a publication that’s issued in successive parts, usually numbered, and continuing indefinitely. Examples of serials include periodicals, newspapers, and annual publications.
**Serial Monograph** – A *serial monograph* is a publication that’s complete, or intended to be complete, in a finite number of individual parts. Examples of serial monographs include a three-part book, or a ten-report serial.

**Source Data Directory** – The *source data directory* is the directory in which the documents you want to convert are stored when you use the ResCarta Data Conversion Tool.

**Subdirectory** – A *subdirectory* is a directory that is one level down from the current directory.

**Source Institution Identifier** – The *source institution identifier* is a required identifier used to define the institution from which a document originated; it must be eight characters (letters and/or numbers) in length. You can use multiple source institution identifiers with your ResCarta database. You are required to supply a source institution identifier when you use the ResCarta Metadata Creation Tool to add metadata to a document. The ResCarta Foundation suggests the use of an existing registered ID (e.g. Library of Congress MARC organization code, Staatsbibliothek zu Berlin, The British Library, etc.) as the identifier, if one exists for your institution. If the normalized length of the identifier is less than eight characters, then padding with numeric zeros is suggested. You can search the Library of Congress MARC code list at the following url: [http://www.loc.gov/marc/organizations/org-search.php](http://www.loc.gov/marc/organizations/org-search.php). You can also add an identifier to the code list by following instructions found at the following url: [http://www.loc.gov/marc/organizations/orgshome.html#requests](http://www.loc.gov/marc/organizations/orgshome.html#requests).
Appendix:

With this version of the toolkit we have moved the configuration files out of the install directory to the user’s home directory. Recent changes in the way Windows operating systems control the access to the “Program Files” directory have caused problems for some installations. The XML files in the config directory maintain last used settings and input/output directory locations for each of the tools.

The configuration locations will vary with versions of the Microsoft Windows operating systems. They are placed into the user home directory under a “dotted” directory called .RcTools.

Examples

Windows 7 = C:\Users\{user name}\.RcTools\config\n
Windows Vista = C:\Users\{user name}\.RcTools\config\n
Windows XP = C:\Documents and Settings\{user name}\.RcTools\config\n
The RcSystem.properties file

This is a new “advanced” configuration file for the ResCarta Toolkit. If one does not exist in the user .RcTools/conf directory, it will be created with these default values on start of the Data Conversion tool.

Several parameters have changed their default values. In particular the Data conversion tool will no longer resample data to comply with the ResCarta “Book” type specified resolutions. If you are scanning to the suggested resolutions there will be no change in the expected output. If you have scanned materials at more than or less than the suggested resolution, NO resampling will take place unless the Resampling to ResCarta standard resolutions parameter is set to “true.”

We also allow for non-archive storage of color images. To make JPEG compressed tiff images instead of uncompressed images adjust the JPEG compressed TIFF output to “true”.

ResCarta Data conversion tool now does intelligent conversion of PDF files. If the page contains color material it will be converted to a color page. If the page contains only grayscale information, the converter will decide whether to create a grayscale image or threshold the image to a bitone file depending on the values of the Tolerant bit depth reduction parameters. Do not adjust these parameters unless you know what you are doing. For more on these parameters, request the “Adjusting bit depth reduction parameters.” pamphlet from the ResCarta Foundation.

The User defined per object pre-conversion JavaScript sets the location of a JavaScript file that can be used for modifying the output of the ResCarta Data conversion tool. A sample JavaScript file is provided on our website download page. For more on using JavaScript to automate conversions see.


36
# ResCarta System Properties

# Note: Boolean property settings are true or false (not case sensitive).
# Paths MUST be specified using forward slash (/) characters and NOT backward slash
# characters.

# JAI
com.sun.media.jai.tileCacheSizeMb=256
com.sun.media.jai.disableMediaLib=true

# JPEG compressed TIFF output
org.rescarta.image.tiff.jpeg=false

# JPEG quality setting is a number greater than 0 and less than or equal to 1.
or.org.rescarta.image.tiff.jpeg.quality=1.0
or.org.rescarta.image.tiff.jpeg.ycbcr=false

# Data Conversion related properties

# Maximum number of threads to spawn during data conversion
# If set to 0, a thread will be spawned for each available core. If set to 1,
# multithreading will be disabled. The data conversion operation will never
# spawn more threads than the number of available cores.
or.rescarta.dct.maxThreads=0

# User defined per object pre-conversion JavaScript
# To enable, this property must contain a path to a JavaScript file that
# defines a function named rcPreConvert. The rcPreConvert function must take
# two parameters. The first parameter, of type java.io.File, is the source
# directory or file being converted. The second parameter, of type
# org.rescarta.metadata.RcObjectMetadata, is the metadata for the object being
# converted.
or.rescarta.dct.preConvertJavaScriptFile=

# Resampling to ResCarta standard resolutions
org.rescarta.image.resample=false

# Ghostscript output logging
org.rescarta.gs.outputLogging=false

# Tolerant bit depth reduction
org.rescarta.image.bitDepthReduction=false
org.rescarta.image.bitDepthReductionReport=true

# Tolerant bit depth reduction - color tolerances
org.rescarta.image.bitDepthReduction.sampleDeviationTolerance=60
org.rescarta.image.bitDepthReduction.sampleDeviationCountTolerance=10

# Tolerant bit depth reduction - grayscale tolerances
org.rescarta.image.bitDepthReduction.grayHistogramAnalysisXAxisRangeBottom=25
org.rescarta.image.bitDepthReduction.grayHistogramAnalysisXAxisRangeTop=230
org.rescarta.image.bitDepthReduction.grayHistogramAnalysisYAxisRangeBottom=0.0030
org.rescarta.image.bitDepthReduction.grayHistogramAnalysisTolerance=0.01

# Tolerant bit depth reduction - write histograms for images with a bit depth
# reduction recommendation of grayscale or binary.
or.rescarta.image.bitDepthReduction.writeGrayHistograms=false
Sample JavaScript file
The following JavaScript file will change the aggregators of an existing ResCarta data objects from 00000001 to SK000001. It will add an additional statement “modified by JavaScript” to the existing title of each object and add a note field listing the original path of the object. And finally it will add one additional subject to each object with the authority of “LCSH”

To use this script you must create a file with its contents and add the path to the file in your RcSystem.properties to the parameter called “org.rescarta.dct.preConvertJavaScriptFile=” for example…

org.rescarta.dct.preConvertJavaScriptFile=C:/myjavasrcipts/metadata/RcPreConvert.js

NOTE: the file location above is correct. You will need to use the “/” instead of the windows “\” separator.

RcPreConvert.js

importClass(org.rescarta.metadata.RcMetadataSubject);

function rcPreConvert(sourceDirOrFile, rcObjectMetadata) {
        rcObjectMetadata.setAggregator("SK" + rcObjectMetadata.getAggregator().substring(2,8));
        rcObjectMetadata.setTitle(rcObjectMetadata.getTitle() + " modified by JavaScript");
        rcObjectMetadata.setNote("From " + sourceDirOrFile.getPath());
        rcObjectMetadata.getSubjects().add(new RcMetadataSubject(rcObjectMetadata,"LCSH", "Subject from JavaScript"));
    }

Adjusting tool memory usage

With this version of the ResCarta Toolkit the basic memory has been increased to use one gigabyte of memory. Most modern systems have much more memory available. The memory limit for 32bit Windows XP is 1300 megabytes even if you have more memory in your system. If you need to reduce the memory usage of your ResCarta tools due to lack of memory in your system, edit the Rc{toolname}.l4j.ini file found in the default installation directory of C:\Program Files\RcTools-3.0.4\bin. Change the text from -Xmx1G to –Xmx512M. The G stands for Gigabyte of memory and the M for megabytes of memory.

ResCarta Tools now support multiple CPU cores and on 64bit operating system can address larger extents of memory.
After installation shortcuts

The new ResCarta Toolkit installer adds a sample data set and the ResCarta-Web application for testing purposes. Under your installation directory you will find an Apache Tomcat server with ResCarta-Web in the Webapps directory. Within the ResCarta-Web directory you will find a RCDATA01 directory with sample data.

Click the “Start ResCarta-Web Server” shortcut. This will start a TOMCAT window. Do not close the window. This window is the server and it will show messages about the status of the web server.

Once the TOMCAT window is opened you can click on the “Open ResCarta-Web in Browser” shortcut to open your default browser and see the contents of the sample RCDATA01 directory found at the default location of ...

C:\Program Files\RcTools-3.0.4\apache-tomcat-7.0.19\webapps\ResCarta-Web\RCDATA01

You can use this directory for testing the tools and viewing your own collections. But it is advised that you create your RCDATA01 directory in another known accessible location and COPY your data to the sample web application for testing.

WARNING DATA LOSS!

The uninstaller will delete all files under the install directory if the “Force the deletion” checkbox is checked. If you have added data to your sample server location UNCHECK this before uninstalling the toolkit.